RX65N Group
Renesas Starter Kit+ Tutorial Manual
For e² studio

RENESAS 32-Bit MCU
RX Family / RX600 Series

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corp. without notice. Please review the latest information published by Renesas Electronics Corp. through various means, including the Renesas Electronics Corp. website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

   "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction, such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAV’s)) for delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the countries asserting jurisdiction over the parties or transactions.

10. Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Handling of Unused Pins
   Handle unused pins in accordance with the directions given under Handling of Unused Pins in the manual.
   - The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in the manual.

2. Processing at Power-on
   The state of the product is undefined at the moment when power is supplied.
   - The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the moment when power is supplied.
   In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the moment when power is supplied until the reset process is completed.
   In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the moment when power is supplied until the power reaches the level at which resetting has been specified.

3. Prohibition of Access to Reserved Addresses
   Access to reserved addresses is prohibited.
   - The reserved addresses are provided for the possible future expansion of functions. Do not access these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
   After applying a reset, only release the reset line after the operating clock signal has become stable.
   When switching the clock signal during program execution, wait until the target clock signal has stabilized.
   - When the clock signal is generated with an external resonator (or from an external oscillator) during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when switching to a clock signal produced with an external resonator (or by an external oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products
   Before changing from one product to another, i.e. to a product with a different part number, confirm that the change will not lead to problems.
   - The characteristics of Microprocessing unit or Microcontroller unit products in the same group but having a different part number may differ in terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
### Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

| The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+, even if Renesas or its affiliates have been advised of the possibility of such damages. |

### Precautions

The following precautions should be observed when operating any RSK+ product:

| This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the Electromagnetic Compatibility Directive and could lead to prosecution. |

| The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment causes harmful interference to radio or television reception, which can be determined by turning the equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures; |

- ensure attached cables do not lie across the equipment
- reorient the receiving antenna
- increase the distance between the equipment and the receiver
- connect the equipment into an outlet on a circuit different from that which the receiver is connected
- power down the equipment when not in use
- consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever possible shielded interface cables are used. |

| The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the following measures be undertaken; |

- The user is advised that mobile phones should not be used within 10m of the product when in use.
- The user is advised to take ESD precautions when handling the equipment. |

| The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the regulatory standards for an end product. |
How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e² studio IDE to develop and debug software for the RSK+ platform. It is intended for users designing sample code on the RSK+ platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e² studio, but does not intend to be a complete guide to software development on the RSK+ platform. Further details regarding operating the RX65N microcontroller may be found in the RX65N Group Hardware Manual and within the provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of the manual for details.

The following documents apply to the RX65N Group. Make sure to refer to the latest versions of these documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web site.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document Title</th>
<th>Document No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User’s Manual</td>
<td>Describes the technical details of the RSK+ hardware.</td>
<td>RSK+RX65N-2MB User’s Manual</td>
<td>R20UT3888EG</td>
</tr>
<tr>
<td>Tutorial Manual</td>
<td>Provides a guide to setting up RSK+ environment, running sample code and debugging programs.</td>
<td>RSK+RX65N-2MB Tutorial Manual</td>
<td>R20UT3892EG</td>
</tr>
<tr>
<td>Quick Start Guide</td>
<td>Provides simple instructions to setup the RSK+ and run the first sample, on a single A4 sheet.</td>
<td>RSK+RX65N-2MB Quick Start Guide</td>
<td>R20UT3893EG</td>
</tr>
<tr>
<td>Smart Configurator Tutorial</td>
<td>Provides a guide to code generation and importing into the e² studio IDE.</td>
<td>RSK+RX65N-2MB Smart Configurator Tutorial Manual</td>
<td>R20UT3894EG</td>
</tr>
<tr>
<td>Schematics</td>
<td>Full detail circuit schematics of the RSK+.</td>
<td>RSK+RX65N-2MB Schematics</td>
<td>R20UT3887EG</td>
</tr>
<tr>
<td>Hardware Manual</td>
<td>Provides technical details of the RX65N microcontroller.</td>
<td>RX65N Group, RX651 Group Hardware Manual</td>
<td>R01UH0590EJ</td>
</tr>
</tbody>
</table>
## 2. List of Abbreviations and Acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td>Analog-to-Digital Converter</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>bps</td>
<td>bits per second</td>
</tr>
<tr>
<td>CMT</td>
<td>Compare Match Timer</td>
</tr>
<tr>
<td>COM</td>
<td>COMmunications port referring to PC serial port</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Versatile Disc</td>
</tr>
<tr>
<td>E1 / E2 Lite</td>
<td>Renesas On-chip Debugging Emulator</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IDE</td>
<td>Integrated Development Environment</td>
</tr>
<tr>
<td>IRQ</td>
<td>Interrupt Request</td>
</tr>
<tr>
<td>LCD</td>
<td>Liquid Crystal Display</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>LSB</td>
<td>Least Significant Bit</td>
</tr>
<tr>
<td>LVD</td>
<td>Low Voltage Detect</td>
</tr>
<tr>
<td>MCU</td>
<td>Micro-controller Unit</td>
</tr>
<tr>
<td>MSB</td>
<td>Most Significant Bit</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PLL</td>
<td>Phase-locked Loop</td>
</tr>
<tr>
<td>Pmod™</td>
<td>This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc. Digilent-Pmod_Interface_Specification</td>
</tr>
<tr>
<td>PSU</td>
<td>Power Supply Unit</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>ROM</td>
<td>Read Only Memory</td>
</tr>
<tr>
<td>RSK+</td>
<td>Renesas Starter Kit+</td>
</tr>
<tr>
<td>RTC</td>
<td>Real Time Clock</td>
</tr>
<tr>
<td>SAU</td>
<td>Serial Array Unit</td>
</tr>
<tr>
<td>SCI</td>
<td>Serial Communications Interface</td>
</tr>
<tr>
<td>SPI</td>
<td>Serial Peripheral Interface</td>
</tr>
<tr>
<td>TAU</td>
<td>Timer Array Unit</td>
</tr>
<tr>
<td>TFT</td>
<td>Thin Film Transistor</td>
</tr>
<tr>
<td>TPU</td>
<td>Timer Pulse Unit</td>
</tr>
<tr>
<td>UART</td>
<td>Universal Asynchronous Receiver/Transmitter</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>WDT</td>
<td>Watchdog Timer</td>
</tr>
</tbody>
</table>

All trademarks and registered trademarks are the property of their respective owners.
# Table of Contents

1. Overview ............................................................................................................................ 8  
   1.1 Purpose ...................................................................................................................................................... 8  
   1.2 Features ..................................................................................................................................................... 8  

2. Introduction ........................................................................................................................ 9  
   2.1 Smart Configurator Plugin .......................................................................................................................... 9  

3. Tutorial Project Workspace .............................................................................................. 10  
   3.1 Introduction .............................................................................................................................................. 10  
   3.2 Connecting the Debugger ........................................................................................................................ 10  
   3.3 Starting e² studio and Importing Sample Code ....................................................................................... 10  
   3.4 Build Configurations and Debug Sessions .............................................................................................. 12  
   3.4.1 Build Configuration ............................................................................................................................... 12  
   3.4.2 Debug Configuration ........................................................................................................................... 13  
   3.5 Running the Tutorial ................................................................................................................................. 14  

4. Reviewing the Tutorial Program ....................................................................................... 15  
   4.1 Program Initialization ............................................................................................................................... 15  
   4.2 Main Functions ....................................................................................................................................... 17  

5. Additional Information ...................................................................................................... 20
1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK+ tutorial started, and basic debugging operations.

1.2 Features

This RSK+ provides an evaluation of the following features:
- Renesas microcontroller programming
- User code debugging
- User circuitry such as switches, LEDs and a potentiometer
- Sample application
- Sample peripheral device initialization code

The RSK+ board contains all the circuitry required for microcontroller operation.
2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas Starter Kit+ (RSK+). The tutorials help explain the following:

- How do I compile, link, download and run a simple program on the RSK+?
- How do I build an embedded application?
- How do I use Renesas' tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not match exactly with that in the actual source files. It is also possible that the source address of instructions illustrated in this manual differ from those in user code compiled from the same source. These differences are minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to e2 studio, the compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-depth information.

2.1 Smart Configurator Plugin

The Smart Configurator plugin for the RX65N has been used to generate the sample code discussed in this document. Smart Configurator for e2 studio is a plugin tool for generating template ‘C’ source code and project settings for the RX65N. When using Smart Configurator, it supports the user with a visual way of configuring the target device, clocks, software components, hardware resources and interrupts for the project; Thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’, ‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example ‘CMT’. Within these code modules, the user is then free to add custom code to meet their specific requirement. Custom code should be added, whenever possible, in between the following comment delimiters:

```c
/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */
```

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit Smart Configurator to change any MCU operating parameters.

RSK sample project, only some functions are used.
For other useful features, refer to the https://www.renesas.com/smart-configurator.
3. Tutorial Project Workspace

3.1 Introduction

e² studio is an open source integrated development tool that allows the user to write, compile, program and debug a software product on many of the Renesas microcontrollers.

3.2 Connecting the Debugger

For this tutorial, it is necessary to provide an external power supply to the board. Use the +5V center-positive PSU supplied with this RSK+ to power the board.

The Quick Start Guide provided with the Renesas Starter Kit+ board gives detailed instructions on how to connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide have been followed and the E2 Lite drivers have been installed:

- Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the socket.
- Connect the E2 Lite Debugger to a free USB port on your computer.
- Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector marked ‘E1/E2 Lite’.
- Connect the +5V center-positive PSU to the PWR connector on the RSK+.

3.3 Starting e² studio and Importing Sample Code

To use the program, start e²studio:

Windows™ 7: Start Menu > All Programs > Renesas Electronics e2studio > e² studio
Windows™ 8.1 & 8: From Apps View, click ‘Renesas Electronics e2studio > e² studio icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics e2studio > e² studio

- Start e² studio by selecting it from the Windows™ Start Menu. The first dialog box to appear will be the Workspace Launcher.
- Click ‘Browse’ and select a suitable location to store your workspace, using the ‘Make New Folder’ option as necessary. Click ‘OK’.
- The e² studio Welcome splash screen will appear. Click the ‘Go to the e² studio Workbench’ arrow button on the far right (circled in the screenshot opposite).
Once the environment has initialized, right click in the ‘Project Explorer’ window and select ‘Import…’

The Import dialog box will be shown. Expand the ‘General’ folder icon, and select ‘Existing Projects into Workspace’, then click ‘Next’.

The Import dialog box will allow you to specify a project to import. Click the ‘Browse’ button and locate the following directory:

C:\Renesas\Workspace\RSK\RSK+RX65N-2MB

Ensure that the ‘Copy projects into workspace’ option is ticked, and then click ‘Finish’.

Click on Tutorial from the list of projects in the ‘Project Explorer’ on the left-hand side.
3.4 Build Configurations and Debug Sessions

3.4.1 Build Configuration

The e² studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

**Release**
This Build Mode has optimisation turned on, and provides little debug information. The C code execution may appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended for final ROM-programmable code.

**HardwareDebug**
This Build Mode has all optimisation turned off, and provides full debug information. This is the best configuration to use whilst developing code as C code execution will be linear.

- Click the top level ‘Tutorial’ folder again, and then the arrow next to the build button (hammer icon), and select the ‘HardwareDebug’ option.
- e² studio will now build the code.
3.4.2 Debug Configuration

- Click the arrow next to the debug button (bug icon). Select ‘Debug Configurations’.

- The ‘Debug Configurations’ dialog box will appear. Click the small arrow next to the ‘Renesas GDB Hardware Debugging’ option.
- The debug configurations for each project will appear. Select the entry for the ‘Tutorial HardwareDebug’.

- The debug configurations control page will then show for the Tutorial project. Change the main tab to ‘Debugger’ and then select ‘Connection Settings’ on the secondary tab bar that appears.
- There is no need to change the debugger settings as they are preconfigured with the Tutorial project.
- Refer to the RSK+RX65N-2MB User’s Manual for details of power supply configuration.

**Note**: e2 studio will display a warning if you attempt to connect with an incorrect power supply setting.

- Click the ‘Debug’ button to continue. e2 studio will now connect to the debugger and download the code to the target.
• A firewall warning may be displayed for ‘e2-server-gdb.exe’. Check the ‘Private networks, such as my home or work network’ box and click ‘Allow access’.

• A user account control dialog may be displayed. Enter the administrator password and click ‘Yes’.

• After downloading the code a dialog box will appear asking if you would like to switch to the ‘Debug perspective’. Click ‘Remember my decision’ to prevent this dialog box from appearing in future, then click ‘Yes’.

• e2 studio will load the new perspective, which is optimised for debugging.

• To change back to the default ‘C/C++’ perspective, from the menu bar select Window > Perspective > Open Perspective > Other.

• The ‘Open Perspective’ dialog box will appear. Click on the desired perspective to select it then ‘OK’.

### 3.5 Running the Tutorial

• Refer to the description.txt file in doc folder of Tutorial project for instructions on how to configure the RSK+ and run the sample code.

• Once the code has been downloaded, click ‘Resume’ button to run the code to the main function. The main function is set as the program entry point by default. The program counter will stop on the first instruction in the main function.

• Click the ‘Resume’ button in the ‘Debug’ perspective to run the rest of the code.

• It is recommended that you run the entire tutorial demo first, before continuing to debug it.
4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e² studio.

4.1 Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial program are used exclusively for initializing the RSK+ device so that the main function can execute correctly. The initialization code is run every time the device is reset via the reset switch or from a power cycle.

- Build and download the code as shown in Section 3.4.
- On the Project Explorer tab expand the ‘Tutorial’ folder by clicking on the arrow next to the folder icon, as highlighted by the red circle.
- Click the arrow next to the ‘src’ folder to show the source files.
- Expand the ‘smc_gen’, ‘r_bsp’, ‘board’, in the order of ‘generic_rx65n’ folder in the same way and double click on ‘hwsetup.c’ to open the file.
- Breakpoints can be set by double clicking at the left-hand edge of the source window. On the line with instruction ‘R_Systeminit();’, double click next to the vertical line to set a breakpoint.

Note: As an alternative, breakpoints may be set in the C/C++ perspective by selecting a line and using Run > Toggle Breakpoint.
• Click the ‘Resume’ button in the Debug perspective (or press [F8]) to run the code up to this breakpoint.

Note: The program counter is indicated by the blue arrow next to the breakpoint.

• Click the ‘Step Into’ button (or press [F5]), to step into the ‘R_Systeminit’ function.

• The ‘R_Systeminit’ function calls several initialization functions which configure the MCU for normal operation. This includes input/output ports, and system clocks.

• The user can step through all the initialization code by clicking the ‘Step Into’ icon and reading the code however for the purpose of this manual, it will be skipped.

• Click the ‘Resume’ button, to run the code up to the main function.

For further details regarding hardware configuration, please refer to the RSK+RX65N-2MB User’s Manual and the RX65N Group, RX651 Group Hardware Manual.
4.2 Main Functions

This section will look at the program code called from with the main function, and how it works. It is necessary to connect the RSK G1CUSB0 to a PC USB port and open a terminal emulation program, such as HyperTerminal, with the settings 19200, 8, N, 1 and N. For information on installation of the RSK virtual COM port driver, refer to the file ‘description.txt’ in doc folder of the e2 studio Tutorial project.

- Right click the ‘R_Config_SCI8_Serial_Receive’ function call and select ‘Run to Line’ to execute the program up to this line. The ‘R_LCD_Init’ function call enables and configures the LCD panel, and ‘R_LCD_Display’ will write “RSK+RX65N-2MB Tutorial Press Any Switch” onto the LCD.

- Set a breakpoint on the ‘R_Config_SCI8_Start’ function call by double-clicking in the breakpoint column.

- Click the ‘Step Into’ button to step into the ‘R_Config_SCI8_Serial_Receive’ function.

- The program counter should now move into the ‘R_Config_SCI8_Serial_Receive’ function definition. This function is an API function provided by the Smart Configurator. It sets up the SCI interrupt handler code to receive a specified number of bytes into a receive buffer. Once the specified number of bytes has been received, the interrupt handler code calls a callback function as shown later on in this section.

- For full details on how to configure a project using Smart Configurator refer to the Code Generator Tutorial Manual.

- Click the ‘Resume’ button to resume program execution.
• The program counter should come to a halt at the ‘R_Config_SCI8_Start’ function.
• Step over the function by clicking the ‘Step Over’ button. Alternatively, press [F6].

The ‘R_Config_SCI8_Start’ function enables the UART interrupts. The program then proceeds to the main while(1U) loop. The code inside the loop waits for user input from either the SCI or RSK+ switches, and then performs an A/D conversion.

• Locate the function call to ‘lcd_display_adc’ inside the while loop.
• Set a breakpoint on the ‘lcd_display_adc’ function call by double-clicking in the breakpoint column.

• In the Project Explorer pane, locate the file ‘Config_SCI8_user.c’ and double-click to open the source file. Scroll down to the function ‘r_Config_SCI8_callback_receiveend’.

• Set a breakpoint on the line of code inside the ‘r_Config_SCI8_callback_receiveend’ function as shown opposite.
• Continue to execute the program by clicking the ‘Resume’ button.
In the terminal emulation window, press the ‘c’ button on the keyboard.

The program will halt at the breakpoint in the ‘r_Config_SCI8_callback_receiveend’ function as shown opposite. Remove the breakpoint by double-clicking on the breakpoint column.

Continue to execute the program by clicking the ‘Resume’ button.

The program will halt at the breakpoint in the main while loop.

Remove the breakpoint by double-clicking on the breakpoint column. Continue to execute the program by clicking the ‘Resume’ button.

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the RSK+. Adjust the potentiometer and press SW1, SW2 or SW3 on the RSK+ and an additional A/D conversion will be performed.

Press the “Suspend” button to halt program execution.

To change back to the default ‘C/C++’ perspective, from the menu bar select Window > Perspective > Open Perspective > ‘C/C++’.

Alternatively, click on the ‘C/C++’ button in the top right corner of the screen, as shown opposite.

This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to the RX Series Software Manual and the RX65N Group, RX651 Group Hardware Manual.

The E2 emulator Lite features advanced logic-based event point trigger system, and full instruction on its use is outside the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’s Manual.
5. Additional Information

Technical Support

For details on how to use e² studio, refer to the help file by opening e² studio, then selecting Help > Help Contents from the menu bar.

Parts of the sample code provided with the RSK+RX65N-2MB can be reproduced using the Smart Configurator tool. Smart Configurator is included as a plug in with e² studio. Source files and functions generated by Smart Configurator are prefixed with ‘Config_’ respectively.

For information about the RX65N Group microcontrollers refer to the RX65N Group, RX651 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas Microcontrollers can be found on the Renesas website at: https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of this document, either in whole or part is prohibited without the written permission of Renesas Electronics Europe Limited.

© 2017 Renesas Electronics Europe Limited. All rights reserved.
© 2017 Renesas Electronics Corporation. All rights reserved.
© 2017 Renesas System Design Co., Ltd. All rights reserved.
# REVISION HISTORY

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>May 31, 2017</td>
<td>First Edition issued</td>
</tr>
</tbody>
</table>

---

**RSK+RX65N-2MB Tutorial Manual**

---

**Page Summary**
RX65N Group